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1. Emails Generated by MEOS 
 
At various points in the review process, you will receive emails from MEOS. These could include the 
following: 
 

• An email assigning you to a review. 

• A reminder to complete your review. 

• A notification that an applicant has submitted a revised application (if you are the designated 
faculty liaison). 

 
These emails are not from a Mandela University server but are generated external to the University 
system. They will come from an external email address (donotreply@infonetica.net) and will have 
the yellow Mandela warning indicated. 
 

 
 
 

2. Logging in as a Faculty Reviewer 
 
Navigate to the MEOS reviewer site using the URL – meos-review.mandela.ac.za 
 
Sign in using your Mandela University credentials. These are the same log in details that are used to 
access your Mandela emails, the staff/student portal, etc. 
 

 
 
After signing in, you will be directed to your work area for reviews. 

https://meos-review.mandela.ac.za/


 
 

2 

3. Work Area Screen 
 

 
 
The Work Area Screen is divided into three sections: 
 

• Top Bar: black bar across top of screen 

• General Work Area: 3 tiles – Notifications, Contacts, Reports 

• My Reviews Work Area: Tiles pertaining to specific reviews required by you 
 

3.1. Top Bar 
 
There are various features you can access from the Top Bar. 
 

(a) Personal Details 
 
Your personal details are accessed by clicking on the arrow on the right of your email address 
on the top bar. 
 

 
 

To update your personal details, complete the Personal Details form and save using the 
[Change Details] button.  
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(b) Help 
 
The Help dropdown has various options. 
 

 
 

• Help – not populated 

• FAQs – not populated 

• Templates – access to review templates if any 

• About – not populated 

• Contact Us 
 

(c) Reports 
 

The Reports area contains any reports that have been compiled by the faculty administrators 
which may be of relevance to the reviewers. 

 

(d) Contacts 
 
The faculty administrators may add people external to Nelson Mandela University as a 
contact, for example, an expert in a specific field. These contacts will appear in this section. 
Their details can be updated by clicking on the required contact name. 
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To update a contact, complete/amend the fields and [Update]. 
 

 
 

(e) Work Area 
 
This takes you back to the main Work Area screen. 

 

3.2. General Work Area 
 
The general work area contains three default tiles. 
 

 
 

(a) Notifications 
 
Clicking on the Notifications tile displays all notifications that are relevant to you as a reviewer. 
Notifications can be searched on message content and/or date. Old notifications can be 
deleted by clicking on the X next to a message. 
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(b) Contacts 
 
The Contacts tile brings up any external contacts that have been added to MEOS by the faculty 
administrators. This may include subject experts, legal experts, etc. 
 

(c) Reports 
 
The Reports area contains any reports that the faculty administrators have compiled and 
shared with the faculty ethics committee. 
 
 

3.3. My Reviews Work Area 
 
These tiles, as shown below, are specific to you as a faculty reviewer. 
 

• Meeting Reviews – contains all protocols that you need to review for an upcoming 
ethics meeting.  

• Liaison Reviews – contains all protocols to which you have been assigned as the faculty 
liaison to assist the researcher(s) and ensure that changes are implemented according 
to the recommendations of the faculty ethics committee. 

• Referrals – contains any protocols which you may have been assigned to as an 
additional reviewer, expert reviewer, etc.  
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4. How will I know that I have an application to review? 
 
You will be sent an email when you have been assigned to review an ethics submission. This will 
contain a direct link to the submission.  
 

 
 
Alternatively, you can log in to MEOS (meos-review.mandela.ac.za) and access it via your work 
area tiles. The number of reviews to which you have been assigned is indicated on the Meeting 
Reviews tile. 
 

 
 
 
 
 
 
 
 
 
 
 
 

https://meos-review.mandela.ac.za/
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5. Actions and Information on an Application Form 
 
Clicking on the Meeting Reviews tile lists the applications to be reviewed. The list can be sorted, if 
required using the arrows to the left of a column title. Clicking on a submission in the list opens it to 
the main page of the form. 
 

 
 
The form has three distinct areas: 
 

1. Action panel 
2. General information 
3. Specific form information 

 

 
 

5.1. The Action Panel 
 
The left-hand Actions panel has the following action buttons: 
 

 

Form submissions – indicates the number of submission (or versions) of a 
particular form. When a form is ‘sent back’ to an applicant for revision, all 
signatures are invalidated and after revisions are made, the form must be signed 
and resubmitted again. Each submission of a form is considered to be a separate 
form version. 
 

 

Project submissions – indicates the number of submissions made on the project 
as a whole – includes amendments, extensions, progress reports, etc.  
 

1. 

2. 

3. 
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Panel Comments – indicates the number of comments that you have made. Panel 
comments are specific to the separate questions on the form. 
 

 

Form Comments – indicates the number of general comments made about the 
form as a whole. 
 

 

Review Application – opens up the form questions that have been completed by 
the applicant. 
 

 

Fac_My Comments – action to create a document containing YOUR comments 
for discussion at the FPGSC. 

 

Fac_Review (Approval) – indicates that you have completed your review of the 
form, that you recommend that the submission be approved with NO 
modifications and alerts the faculty administrator(s) of this. 
 

 

Fac_Review (Changes) – indicates that you have completed your review of the 
form, that you recommend that the submission be approved with modifications 
and alerts the faculty administrator(s) of this. 
 

 

Fac_Review (Resubmission) – indicates that you have completed your review of 
the form, that you recommend that a resubmission is required and alerts the 
faculty administrator(s) of this. 
 

 

5.2. General Information 
 

 
 
The following should be noted: 
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• The Project Title is the short title of the project. In most cases, this will be the approved title 
of the project, but in some instances, where the title is lengthy, the applicant may opt to 
define a short project title. 

• The Review Reference is made up of the year the specific form being reviewed was 
submitted, the committee it was first submitted to, the project ID and a form submission 
number. The form submission number changes with each iteration of the form submitted. 

• The Project id is the one constant throughout the life of the project. The project id is 
hyperlinked and clicking on it brings up a list of any form submitted on the project from 
extensions to amendments to closures, etc. This enables a reviewer to check on the history 
of the project. 

• Assigned Reviewers indicates any reviewers that have been assigned to the submission. 
There are four reviewer types: 

o Faculty reviewer – reviews the submission for discussion at the faculty meeting. 
o Faculty liaison - reviews the submission for discussion at the faculty meeting; 

assigned to liaise with the applicant after the meeting if changes are required. 
o Faculty referral – assigned to assist on a submission if requested, this could be an 

expert in the field, etc. 
o Faculty chair – assigned to review a submission at the request of the reviewers or the 

faculty administrator. 
 

5.3. Specific Form Information 
 

(a) The Timeline Tab 
 

The Timeline tab indicates the form timeline both on a graph and as a list of actions. (Please 
ignore the Clock Status and Clock Information columns). The timeline can be moved by placing 
one’s mouse anywhere on the timeline and moving it back or forwards. 
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Clicking on either a blue bubble on the timeline or on one of the listed actions, reveals further 
information about the action that has been performed.  
 

 
 

(b) The Project Tab 
 

The Project tab provides a brief overview of the project as a whole and all form submissions. 
On a new project, the following will be displayed. 
 

 
 
However, on an older project, there may be a number of submissions displayed. This is very 
useful when you are reviewing the sub-form of a project, for example, an amendment. You 
can easily open and check the original approved application or an adverse event report, etc. 
Clicking on any of the forms displayed will open them. 
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(c) The Documents Tab 
 

The documents tab provides access to all documents uploaded with a particular form 
submission. These can be viewed or downloaded. 

 

 
 

(d) The Data Tab 
 

This tab is not currently in use. 
 

(e) The Contacts Tab 
 

The Contacts Tab lists both form and review contacts added to the form. The screenshot 
below indicates the PRP and PI. This list could include co-workers, co-supervisiors, etc. 
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6. Reviewing an Application 
 

6.1. Opening an Application 
 

 
 
Click on the [Review Application] button in the left-hand action panel of an opened submission to 
access the sections and questions on a form. 
 

 
 
The blue hyperlinked questions provide quick access to the various questions on the form. The 
questions shown in black cannot be accessed as they are not relevant to the particular submission 
(for example, in the submission above, there are no co-workers, therefore this question is not 
required). 
 
The panel on the left-hand side of each page provides the following functionality. 
 

 

Takes one to the previous page of the form.  

 

Takes one to the next page of the form. 

 

Takes one to the page of the form on which all sections and questions of the form 
are displayed. This enables one to move between pages of the form easily and 
quickly. 
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Takes one to the main screen which contains the tabs as well as the action buttons 
to provide feedback and alert the administrator that the review has been 
completed. 

 

Enables one to view/download the form as a PDF.  

 

Displays all documentation uploaded as part of the form. 

 

 

Shows any comments made on specific questions by faculty administrator, 
reviewers, etc.  Comments that you make will increase this number. Please note 
that your review comments are not visible to the applicant, nor other reviewers. 
Any faculty administrator comments made are visible, as these are not regarding 
issues of an ethical nature but rather poorly completed forms, incomplete 
documentation, etc.  

 

Shows any changes made by the applicant in response to issues raised. The changes 
shown are those between the submission being reviewed and the last submission 
that the applicant made. This will be covered in more detail below. 

 

Shows any general comments made on the form as a whole by faculty 
administrator, reviewers, etc.  Comments that you make will increase this number. 
Please note that your review comments are not visible to the applicant, nor other 
reviewers. Any faculty administrator comments made are visible, as these are not 
regarding issues of an ethical nature but rather poorly completed forms, incomplete 
documentation, etc. 

 

Action button to add new comments to a question on the form. 

 

6.2. Reviewer Anonymity 
 
The review comments that you make on the form for feedback and discussion at the faculty ethics 
meeting are anonymous and independent.  
 

• You cannot see other reviewer comments and they cannot see yours.  

• The applicant cannot view any comments made online; they will receive an Action Memo 
containing the committee feedback after the meeting. 
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Your comments are visible to the faculty administrator and the faculty ethics chair.  
 
You are able to view any comments that the faculty administrator has made during their initial 
check of the submission. These comments go directly to the applicant, are visible to all and are not 
review-related. 
 

6.3. Adding Review Comments (Panel Comments) 
 
To add a comment to a specific question, navigate through the form to that question. Click on the 
New Comment action button. 
 

 
 
The questions on that page will be highlighted and a [Select Me] will appear in the top-right hand 
corner of the question block. 
 

 
 
Click on the [Select Me] of the question that you wish to comment on. Add your comment and 
[Save].  
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6.4. Reviewing and Editing your Panel Comments 
 
The [Panel Comments] button will increase with each comment made. 
 

                                 
 
Click on the [Panel Comments] button to open all comments made. Any comments made by the 
ethics administration team during the initial check will appear under the Previous tab. Click on [Edit] 
to open the comment that you wish to amend. 
 

 
 
Update the Comment and [Save]. You can also delete the comment if required. 
 

  
 
 
Please note: Edited/deleted panel comments remain as part of the history of the Project and can be 
accessed under the History Tab under the Project ID link. 
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6.5. Adding General Comments (Form Comments) 
 
General comments are any comments about the application that do not pertain to a specific form 
question. A form comment should also include your recommendation on approval. Forms 
comments are independent. Other reviewers cannot view your comments and you cannot view 
theirs. 
 
Clicking on the [Form Comments] action button opens the Form Comments pop-up. 
 

 

 
 
Click on + Add Comment. Add your general comment and [Save]. 
 

 
 
To edit a form comment, click on the [Form Comments] action button to bring up a list of the forms 
comments that you have made. Click on the required comment. 
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Edit your comment and [Save]. The comment can also be deleted if required. 
 

 
 
Please note: Edited/deleted form comments remain as part of the history of the Project and can be 
accessed by under the History Tab under the Project ID link. 
 

6.6. Submitting your Review 
 
After completing your review, navigate to the main application screen by using the [Timeline] action 
button. 
 

  
 
Click on one of the [Fac_Review] feedback action buttons. 
 

 or  or  
 
Add a comment to the Timeline Notes. It is suggested that this is your overall recommendation 
regarding the application. 
 

• Approved with modifications 

• Approved with no modifications 

• Resubmission (major modifications requiring the submission to serve at a subsequent faculty 
meeting) 

 
Click the green [Fac_Review] button and then [Yes]. The Timeline comment will be visible to all on 
the Timeline as outlined in the The Timeline Tab section above. 
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6.7. Amending your Submitted Review Comments 
 
Reviews can be amended after the [Fac_Review] feedback button has been actioned. The 
submission remains under the Meeting Reviews tile in your Work Area until the faculty meeting/  
 
To amend your review, open the required form and click on [Review Application].  
 
To edit Panel comments and Form comments, access the full list directly by clicking on the relevant 
buttons in the left-hand panel. 
 
Alternatively, navigate through the form using the [Previous] and [Next] buttons to the relevant 
question. A number is indicated in the speech bubble next to any questions that have been 
commented on. Please note that the number indicates the comments made by ALL committee 
members who have already reviewed the submission. You will, however, only be able to view your 
comments. 
 

 
 
Click on the speech bubble to open up the specific comment for editing or deletion. 
 

 
 
Alternatively, Click on the [New Comment] action button in the left-hand button to add further 
comments as outlined in the Adding Review Comments (Panel Comments) section. 
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7. Compiling YOUR Comments for Discussion 
 
An action has been included that enables you to download a document of your comments that can 
be used for discussion purposes at a review meeting.  
 
Kindly note: Only your comments will be downloaded and not those of other reviewers on the same 
submission. It is not necessary to send your comments to the faculty administrator to compile as 
they administrator has the ability to download a document containing all comments on the 
application. 
 
Click the [Fac_My Comments] action button on the main screen of the application. 
 

 
 
This opens a pop-up which pulls in all of your comments on the submission.  
 
You can edit the information on the pop-up as required using the edit tools in the centre of the pop-
up.  
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Click on the green [Fac_My Comments] and [Yes]. An attachment will pop up which can be 
downloaded. 
 

 
 
 

8. Attending to Revisions as the Faculty Liaison (Post-meeting) 
 

8.1. How will I know if I am the Faculty Liaison on a Submission? 
 

(a) By Email (assigning you as a reviewer) 
 

If you are assigned as the faculty liaison after the faculty meeting has taken place, you will 
receive an email indicating to this effect. Clicking on the link in the email will take you directly 
to the form.  
 
If the status of the form is indicated as “Changes Required (Faculty)”, there will be no actions 
available to you other than [Review Application]. In this status, the application has been 
unlocked and the applicant is able to edit it before having it signed and resubmitted for your 
review and approval. 
 

 
 
If the status of the form is “Superseded”, this means that the applicant has already made 
revisions and resubmitted. In this case, click on Work Area in the black top-bar and then on 
the Liaison Reviews tile to access the most recent submission of the form.  
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(b) By Email (copied in on Action Memo sent to the applicant) 
 

You will be copied in on the Action Memo email that the applicant/PRP is sent. This Action 
Memo can also be accessed from the Timeline tab. Click on the Attachment icon in the list of 
Actions. 
 

 
 

(c) Liaison Review Tile 
 

If you have been assigned as the faculty liaison, the Liaison Review tile in your MEOS work 
area will indicate the number of submissions to which you have been assigned as liaison. 
 

 
 

8.2. Explanation of Form Statuses 
 
Click on the Liaison Reviews tile to open the list of submissions to which you have been assigned 
as liaison. The current status of the form is indicated. 
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The Review Status of the form indicates if the applicant needs to make revisions and submit to you 
for approval, or if the revisions have been made and you need to review the changes. There are 4 
possible review statuses. 
 

• Changes Required (Faculty) – no action is required by you as the liaison. The applicant 
needs to make revisions based on the Action Memo emailed. The Action Memo will also 
be copied to you.  

 

• Changes Submitted (Faculty) – ACTION is required by you. The applicant has made 
revisions; the form has been re-signed and submitted. You need to review the revisions 
and either request further revision or approve the revisions. 

 

• Resubmission Required (Faculty) – no action is required by you as the liaison. The 
applicant needs to make revisions based on the Action Memo emailed. The Action 
Memo will also be copied to you.  

 

• Resubmission by Applicant (Faculty) – ACTION is required by you. The applicant has 
made revisions; the form has been re-signed and submitted. You need to review the 
revisions and either request further revision or approve the revisions. 

 

8.3. How will I know when an Applicant has made Revisions on a Submission? 
 
You will receive an email indicating that the applicant has submitted the revisions for your review. 
Click on the direct link or access the submission via your MEOS work area and the . 
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Click on [Review Application] to open the form to review the changes.  
 

  
 

8.4. How do I Review Changes Made on a Form? 
 
After opening the form using the Review Application button, the number of changes made by the 
applicant is indicated on the [Changes] tile.  
 

 
 
Clicking on [Changes] opens up a list of all questions that have been changed by the applicant since 
the last form submission. 
 

 
 
Click on the question that you wish to view. This takes you directly to the question. Click on the 
[View Changes] button.  
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Deletions are indicated in red. Additions are indicated in green. To revert to the revised submission, 
click the [View Latest] button. 
 

 
 
Alternatively, you can navigate through the form, page by page, using the Previous and Next 
buttons. Any changes made are indicated by the blue ‘View Changes’ strip. 
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8.5. How do I Request Further Changes to a Form? 
 
If you are not satisfied with the revisions made, add a comment to the relevant question(s) using 
the process outlined in the Adding Review Comments (Panel Comments) section above. 
 
After you have added further comments, click on the [Timeline] action button in the left-hand panel 
to return to the main screen of the form. 
 

 
 
Click on the [Fac_Request More Changes] button. 
 

 
 
An Action Memo will be generated for the applicant. The comments that you have made on the 
latest submission will be pulled into the Action Memo. They can be edited to ensure that they are 
clear for the applicant. You can add additional feedback if required. 
 
Please ignore the banner in yellow. This is a standard banner. Your comments will not be visible to 
the applicant on the form, and you are unable to mark them as visible. Your comments will be sent 
on the Action Memo as below.  
 
Edit the Action Memo using the editing tool in the centre of the screen. 
 
Add a mandatory timeline note. This can be specific or generic, for example: Changes required. 
 
When you are satisfied with the Action Memo, click the green [Fac_Request More Changes] button 
and then [Yes]. 
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After sending the Action Memo, the status of the form will be updated from Changes Submitted 
(Faculty) to Changes Required (Faculty). 
 

 
 
By sending the Action Memo, all signatures are invalidated, and the form is opened for the applicant 
to make further revisions and resubmit for your approval. 
 
 
 
 
  
 
 
 
 
 
 
 

IMPORTANT: 
It is not mandatory to make comments on the form to request further changes. You may prefer 
to have a meeting or a telephone discussion with the applicant. You may have used email to 
convey the further changes required. However, you MUST re-open the form for the applicant 
using the [Fac_Request More Changes] action button, even if there are no comments on the 
Action Memo. If this is not done, the applicant is unable to make the revisions for your approval. 
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9. Approving Revisions 
 
When you are satisfied with the changes made by the applicant, navigate to the main screen of the 
form by clicking on the submission under the [Liaison Reviews] tile or navigating to it from the form 
itself using the [Timeline] action. Click on the [Fac_Liaison Approve] action. 
 

 
 
Add a comment to the mandatory timeline notes box and click [Fac_Liaison Approve] and [Yes]. 
 

 
 
This action sends an email to the faculty administrators, informing them that you have approved 
the revisions and that the application can be progressed. For low-risk application, a letter of 
approval will be issued. Medium and high-risk applications will be referred to REC-H for review. 
 
After you have approved the submission, it will no longer be located in your Work Area. The faculty 
administrator is sent an email indicating that the changes have been approved.  
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10. Frequently Asked Questions 
 

10.1. I am the faculty liaison on a submission, but I have ‘lost’ the action memo. 
 
Click on the Notifications Tile in your Work Area. The action memo will be attached to the relevant 
notification. 
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